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About Xmanager  
Xmanager® is a powerful, convenient PC X server software package that operates in the 
Windows® environment. Users can bring the UNIX/Linux desktop to their Windows PC via 
Xmanager. Additionally, the X application can be safely executed through SSH (secure shell) 
even when a user’s PC is inside a private network or there is a firewall in between a user PC 
and remote server.  

Xmanager offers diverse functions, such as setting multiple servers, multi-visual, multi-
monitor, multiple user settings, multiple XDMCP sessions, and SSH security reinforcement. 
Xmanager provides a variety of premium options for advanced users and a simple user 
interface for first-time users. 

Xmanager comprises Xmanager, Xconfig, Xbrowser, Xstart and several other utilities. 

• Xmanager is an X server program for PC. X client, a graphic remote UNIX/Linux 
application, can show a screen in Windows through Xmanager. Xstart and Xbrowser 
run Xmanager when running a remote X application or when bringing the whole GUI 
desktop screen of a remote host.  

• Xconfig creates and manages Xmanager server profile. Xmanager profile sets 
various Xmanager options, such as window modes, font catalogs, and colors.  

• Xbrowser finds a remote UNIX/Linux host and enables connection with the remote 
host using the XDMCP protocol. Xbrowser compositely manages Xstart, Xshell, and 
Xftp sessions in addition to XDMCP sessions. Users can run several sessions 
simultaneously and create shortcut icons for each host.  

• Xstart enables the execution of a remote X application on a user’s PC. When 
connecting with a remote host, it supports SSH, TELNET, RLOGIN, REXEC, RSH and 
LOCAL protocols. A remote host command can be conveneintly executed, on a user’s 
Windows PC via Xstart.  
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Key Functions 
This section provides descriptions of the key Xmanager functions. 

Connection and Startup 
• Xbrowser managing Xstart and XDMCP sessions 
• Integrated management of Xmanager, Xshell, and Xftp sessions in Xbrowser 
• XDMCP, SSH, RSH, REXEC, RLOGIN and TELNET connection protocols 
• Up to 128 X client connections per Xmanager session 
• Shortcut to Xstart and XDMCP sessions 
• Advanced prompt recognition setting and remote command script in Xstart 
• Secure XDMCP for XDMCP connection to outside firewall and private network  
• IPv6 support 
• MIT Kerberos authentication support 
• Supports having multi tabs in a single window 
• Supports displaying multiple tab groups in a single window 

 

Installation and Distribution 

• Supports Windows 2000 SP4 or higher 
• Supports Windows terminal server and Citrix MetaFrame for Windows  
• Session sharing for Windows terminal service 
• Silent Installation 
• Multi-user setting 
• Simple session and server profile distribution 
• User-designated session path 

Security 

• SSH1/SSH2 protocols supporting public key authentication 
• Creates SSH public key 
• SSH user authentication agent 
• Access control by host 
• XDMCP connection using SSH secure tunnel 

X Server 

• High-performance X11R7 PC X server 
• GLX 1.3, OpenGL 1.2 extension protocol (Xmanager Enterprise version) 
• X Rendering extension protocol 
• Supports RandR Exension  
• Multi-server setting 
• Multi-user setting 
• Multi-monitor 
• Multi-network adapter 
• Multi-XDMCP sessions 
• Automatic display number allocation 
• Single & multiple window mode 
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• Panning and auto-raise in local window manager 
• Multi-visual 
• 256-color visual in True Color video device 
• Automatic color substitution for PseudoColor visual 
• Backing Store 
• Complete Planemask function for 256-color applications 
• Wheel mouse 
• 3-button mouse emulation 
• GUI keyboard editor 
• Real-time keyboard change using shortcut key 
• Sound files for XBell requests 
• Local resources database 
• Window printing in Multiple Window mode 
• Automatic copy & paste between X application and Windows application  
• Notification area icon 

Font 

• Font compiler 
• Font server 
• BDF, PCF font formats 
• Automatic font substitution 
• Additional fonts packages for various languages and X applications 

Recommendations 
• Processor: Intel® compatible 
• Operating System: Microsoft Windows® 2000 SP4 or higher 
• Storage Space: 100MB or more reserve space 
• Network: TCP/IP network 
• Program: Internet Explorer® 6.0 or higher 

Install and Uninstall 
The Xmanager installation program was created using InstallShield®. A variety of installation 
options can be changed during installation. However, it is often sufficient to simply click [Next]. 

To uninstall Xmanager, use the standard Windows add/remove functions. Run [Add/Remove 
Program] in the control panel and select to uninstall Xmanager or Xmanager Enterprise 
from the list. Note that when Xmanager Enterprise is uninstalled, other programs, such as 
Xshell, Xftp and Xlpd, are also removed.  

Even when the program is uninstalled, the registry information, log files and data files created 
by the user are not removed. The information and files are available for reuse when the 
program is reinstalled. If you want to remove all the files and registry information completely, 
remove the following explicitly: 

Registry Information: 
• \HKEY_CURRENT_USER\Software\NetSarang\Xmanager 

• \HKEY_CURRENT_USER\Software\NetSarang\Xmanager Enterprise 
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File and Folder: 

• %APPDATA%\NetSarang\Xmanager 

• %APPDATA%\NetSarang\Xmanager Enterprise 
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Start 
Xmanager provides Xbrowser and Xstart, two basic tools for accessing a remote UNIX/Linux 
host. Xbrowser can be conveniently used by most users as it enables to bring the entire 
remote desktop via XDMCP (X display manager control protocol). Xstart is simpler and quicker 
than an XDMCP connection, as it is a method to run a single remote X application. 

When Xmanager is successfully installed, Xstart and Xbrowser programs can be found in 
the Xmanager folder on the desktop.  

 Note 

Run Xmanager - Passive in the Xmanager installation folder for Xmanager to enter 
standby mode for X application connection. Users can then run a remote X application 
using Xstart or other tools.  

Run Xmanager - Broadcast in the Xmanager installation folder and Xmanager 
broadcasts a XDMCP Query message through network. Hosts that respond to the query 
message are listed in the Chooser window. A host can be selected from the list and a 
connection to it can be made.  
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Start with Xbrowser 
To use Xbrowser, set a remote UNIX/Linux host to support XDMCP service for a remote X 
server. In general, dtlogin, kdm, gdm, or xdm must be running on the host. For details about 
XDMCP service setting, see manual for the UNIX/Linux concerned.  

1. Open Xmanager or Xmanager Enterprise folder on your desktop. 

 

Fig. 1: Xmanager Enterprise Folder 

2. Run Xbrowser. 

 Note 

Xbrowser automatically finds all UNIX/Linux hosts in the local network. If the UNIX/Linux 
host to access is on a different network than the user’s PC, register the UNIX/Linux host IP 
address or broadcast address in the Options dialog box. For setting details, see ‘Automatic 
XDMCP Session’. 

If a UNIX/Linux host is not displayed in the Xbrowser window, it means that the host is 
not prepared for an XDMCP connection.  
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Fig. 2: Xbrowser main window 

3. Double-click a host to connect to. Graphic login screen opens.  

 Note 

If graphic login screen is not displayed, it is possible there is a firewall between the user’s 
PC and a remote host.  
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Fig. 3: XDMCP login screen 

4. Log in to host by entering the account name and password. Remote desktop opens.  

 Note 

There may be a problem in the user account login shell script if the remote desktop is not 
displayed after entering account and password. 
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Fig. 4: UNIX desktop executed in Windows 

If you experience problems using Xbrowser, visit the customer support page in the following 
address: 
 http://www.netsarang.com/support/main.html  
Information about the XDMCP settings in UNIX/Linux server and related tips can be found on 
the customer support page.  

Start with Xstart 
Xstart helps run a remote X application. Once an Xstart session is created, the remote X 
application can be executed by simply clicking it in Windows.  

1. Run Xstart in Xmanager folder. 
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Fig. 5: Xstart main window 

2. Click [New]. New Session dialog box is displayed. 

 

Fig. 6: Xstart New Session dialog box 

3. Enter new session name and click [OK].  
4. Enter the remote UNIX/Linux host name or IP address in [Host]. 
5. Select one of the protocols supported by the host from [Protocol].  
6. Click [Setup] to set protocol options, such as port or timeout.  
7. Enter remote host user account in [User Name].  
8. To save user password in session, select [Authentication] as Password and click the [Setup] 

button on the right.  
Password Setup dialog box is displayed. 
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Fig. 7: Password Setup dialog box 

9. Enter a command to be executed in a host in [Command]. To run xterm, enter the 
following command: 
/usr/bin/X11/xterm –ls –display $DISPLAY 

 Note 

By pressing the button below the [Command] label, a list of generally used sample xterm 
commands registered by UNIX/Linux type will be displayed. Select the xterm command 
suited to UNIX/Linux to connect to, or add/remove frequently used commands by opening 
Registered Commands dialog box.  

10. Click [Run]. xterm window opens. 

 

Fig. 8: xterm window 
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If you experience problems using Xstart, visit the customer support page in the following 
address: 
 http://www.netsarang.com/support/main.html 
Most problems are caused by a firewall, user PC, or network settings. In some cases, users 
may have to consult with network or system administrators.  

Exit Xmanager  
To end a remote X application started by Xstart or Xbrowser, select [Close] from Xmanager 
system menu. For Xmanager system menu, see ‘Window Mode’.  

To Automatically Exit Xmanager when All Remote X Applications are closed: 
1. Select [Properties] from Xmanager system menu. Profile Properties dialog box is 

displayed.  
2. Select [Exit Xmanager when all connections are closed] from the [General] tab. 
3. Xmanager is finished when all X application windows are closed.  

 Note 

If [Exit Xmanager when all connections are closed] option is not selected, Xmanager 
becomes initialized when all remote X applications are finished and stands by for a new X 
application connection.  
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Session Management 
Sessions have connection information to connect to a remote host. Users can designate 
different options and server profiles for each connection by creating a session.  
Session types are divided into automatic XDMCP session, static XDMCP session and Xstart 
session. 
 

Icon Session Type Description 

 

Automatic 
XDMCP 

Xbrowser sends a broadcast message to local LAN and dynamically 
finds the hosts. To find another subnet host, enter host IP address 
in the Options dialog box.  
All automatic sessions use the same settings. To change session 
settings, right-click on a session, select [Save As] and save the 
session. Then, right-click on a newly created session and select 
[Properties]. In this case, the newly created session becomes a 
static XDMCP session.  

 

Static 
XDMCP 

Static session is a session created by a user. Static session can be 
created by copying an automatic session or using New Session 
Wizard. If a remote host does not respond to an XDMCP request 
message, the icon is displayed dimly.  
Users can create shortcut, change settings for this session and send 
this session to another user through e-mail.  

 

Xstart Xbrowser creates and manages Xstart sessions. Additionally, users 
can also manage these sessions in Xstart. Xbrowser and Xstart 
share all Xstart session. 
By double-clicking Xstart session, users can conveniently run a 
remote X application in their Windows.  

 Note 

Xstart session is useful when running remote X applications one by one. This session 
connects to a remote host, automatically executes a designated command, and opens an X 
application in user’s Windows.  

XDMCP session is used to bring the GUI login screen and the entire remote host desktop 
environment. Xmanager supports all UNIX/Linux GUI desktop environments including CDE, 
KDE and GNOME. 
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Xstart Session 
By creating an Xstart session, a remote host X application can be executed in a user’s PC. 
Xstart automatically processes the remote host login process and executes remote X 
applications designated by a user.  

Users can create Xstart sessions using Xstart and Xbrowser programs. 

To Create a Session with Xstart: 
1. Run Xstart in Xmanager Folder. 
2. Click [New]. New Session dialog box is displayed. 
3. Enter a new session name and click [OK].  
4. Enter the remote UNIX/Linux host name or IP address in [Host]. 
5. Select one of the host supported protocols from [Protocol].  
6. Click [Setup] to set options by protocol, such as port or timeout.  
7. Enter remote host user account in [User Name].  
8. To save user password in session, select [Authentication] as Password and click the [Setup] 

button on the right. Password Setup dialog box is displayed. 
9. Enter a command to be executed in a remote host in [Command]. To run xterm, enter 

command as follows: 
/usr/bin/X11/xterm –ls –display $DISPLAY 

 Note 

Press the button below the [Command] label, to see a list of generally used sample xterm 
commands registered by UNIX/Linux type. Select the xterm suited to UNIX/Linux to 
connect to or add/remove frequently used commands by opening Registered Commands 
dialog box.  

10.  Click [Save]. 

To Create a Session with Xbrowser: 
1. Run Xbrowser in Xmanager Folder. 
2. Point to [New] in the [File] menu and select [Xstart Session]. New Session Properties 

dialog box is displayed. 
3. Enter [Session] name in [General] tab. 
4. Enter the remote UNIX/Linux host name or IP address in [Host]. 
5. Select one of the host supported protocols from [Protocol].  
11. Click [Setup] to set options by protocol, such as port or timeout.  
6. Enter remote host user account in [User Name]. 
7. Enter password to user account in [Password]. 
8. Enter a command to be executed in a remote host in [Execution Command]. For example, 

enter command as follows to run xterm: 
/usr/bin/X11/xterm –ls –display $DISPLAY 

9. Click [OK]. 

 Note 

Users can also create Xstart session using New Session Wizard provided in Xbrowser. If 
the Xbrowser session category is set as Xstart, point to [New] in the [File] menu and 
select [New Session Wizard] to open it.  
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To Create Shortcut to Xstart Session: 
1. Run Xstart. 
2. Select a session from [Session] list. 
3. Click the arrow button to view more menus and click [Create Shortcut]. Browse For 

Folder dialog box is displayed.  
4. Select a folder in which to create shortcut.  

Automatic XDMCP Session 
Xbrowser sends an XDMCP Broadcast message to local network or a network designated by a 
user and shows the hosts that respond to the message. These sessions are automatically 
created by Xbrowser and users do not need to create them by themselves. So, these sessions 
are called automatic sessions. 
In general, all UNIX/Linux systems support XDMCP service, and there should be no problem 
finding hosts in the Xbrowser window. In some cases, a remote host is set not to support 
XDMCP service and, as a result, it is not displayed in Xbrowser. In this case, contact the 
system administrator of the concerned host so that it supports XDMCP service.  
Xbrowser provides an option to find hosts in other networks. Additionally, it offers an option 
to turn off broadcast function in case there are too many hosts in local network.  

To Find Host in Another Network: 
1. Run Xbrowser. 
2. Select [Options] in the [Tools] menu. Options dialog box is displayed. 
3. Enter the host name or IP address to find in [Search] section or enter network address to 

find all hosts available.  
4. Click [Add].  
5. Click [OK].  

To Turn off Local Broadcast Option: 
1. Run Xbrowser. 
2. Select [Options] in the [Tools] menu. Options dialog box is displayed.  
3. Unselect [Search for local hosts (XDMCP Broadcast)].  
4. Click [OK].  

 Note 

If there are too many hosts in the user’s local network and there are a limited number of 
hosts to use, it is convenient to turn off [Search for local hosts (XDMCP Broadcast)] option 
and add only the necessary host to the list of search addresses. 

 

Static XDMCP Session 
In addition to automatic session, Xbrowser provides static sessions, such as Passive, XDMCP 
Query, XDMCP Broadcast, XMDCP Indirect and Secure XDMCP. Unlike automatic sessions, static 
sessions are displayed in Xbrowser window at all times and can be created, modified, or 
deleted by users.  

To Create Passive Session: 
1. Run Xbrowser. 

Error! Use the Home tab to apply 제목 1 to the text that you want to appear here. | 17 



 
2. Select XMDCP in the sessions category on the left. 
3. Point to [New] in the [File] menu and select [New Session Wizard]. New Session Wizard 

is displayed. 
4. Select None (Passive) in [Method] and click [Next].  
5. Select a server profile from [X Server Profile] and click [Next].  
6. Enter a session name in [Name].  
7. Click [Finish].  

 Note 

When a passive session is executed, Xmanager enters a mode to stand by for an X 
application connection. Then run a remote X application by using Xstart or a terminal 
program, such as telnet.  

To Create XDMCP Query/Broadcast/Indirect/Secure XDMCP Session: 
1. Run Xbrowser. 
2. Select XDMCP in sessions category.  
3. Point to [New] in the [File] menu and select [New Session Wizard]. New Session Wizard 

is displayed.  
4. Select XMDCP Query, XDMCP Broadcast, XDMCP Indirect or Secure XDMCP in [Method].  

 Note 

XDMCP Query connection is made directly with a designated host and GUI login screen can 
be brought to a user’s window.  

XDMCP Broadcast connection is a method where Xmanager opens Chooser dialog box and 
lists hosts available for connection.  

XDMCP Indirect connection is similar to XMDCP Broadcast connection. However, Chooser 
dialog box is displayed by a remote host, not Xmanager.  

Secure XDMCP connection can be used when Xmanager is inside a firewall or a private 
network and a remote host is outside a firewall or a private network and thus users cannot 
make a direct XDMCP connection. If SSH server is in operation on this remote host, XDMCP 
connection with a remote host can be achieved using the SSH tunneling of Secure XDMCP 
connection.  

5. Enter the remote host name or IP address in [Host] and click [Next].  
6. Select server profile from [X Server Profile] and click [Next].  
7. Enter a session name in [Name].  
8. Click [Finish].  

To Create Shortcut to Static Session: 
1. Run Xbrowser. 
2. Right-click on a session. 
3. Select [Create Shortcut]. 

To Send Session through E-mail: 
1. Run Xbrowser. 
2. Right-click on a session. 
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3. Point to [Send To] and select [E-Mail Recipient].  

To Bring Session: 
1. Drag a session from an external folder. 
2. Drop it in Xbrowser window. 

 Note 

Only static sessions saved in a file can be dragged and dropped. Automatic sessions cannot 
be brought in.  

To Share Session with Other Users: 
1. Run Xbrowser. 
2. Right-click on a session. 
3. Select [Sharing]. 

 Note 

This task requires administrative permissions. Shared sessions are moved to a shared 
folder.  

To Save Automatic Session as Static Session: 
1. Run Xbrowser. 
2. Select an automatic session and right-click on it.  
3. Select [Save As]. 

Session Properties Setting 
A session has basic connection information, such as a host name and a port. In addition, you 
can configure XDMCP settings, a connection address, a server profile and a display number.  

To Change Session Connection Information: 
1. Run Xbrowser. 
2. Right-click on a session. 
3. Select [Properties]. Session Properties dialog box is displayed.  
4. Modify connection information in the [Connection] section of the [General] tab.  

 Note 

For details about XDMCP session and Xstart session properties, see ‘XDMCP Session 
Properties’ and ‘Xstart Session Properties’ respectively.  

To Allocate a Display Number: 
1. Start Xbrowser. 
2. Right-click on a session. 
3. Select [Properties]. Session Properties dialog box is displayed. 
4. Click [X Server] tab. 
5. Turn off [Allocate display number automatically]. 
6. Enter a display number in [Display Number]. 
7. Click [OK]. 

 Note 
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In case display number is automatically allocated, each session holds an intrinsic display 
number starting from the default display number set in profile. When several Xmanager 
sessions are executed, each session gets a unique display number and it is displayed on 
the title bar of Xmanager such as [:0.0]. The first number is the display number and the 
second number is the screen number. In Xmanager, the screen number is always 0.  

Display number must be a value between 0 and 255. Xmanager obtains TCP port number 
by adding 6000 to a display number. If a user enters the number 10 in [Display Number], 
Xmanager communicates with X applications using TCP port 6010. Some UNIX servers 
cannot recognize a three-digit number. It is thus safe to use a number smaller than 100.  

To Designate a Specific Profile to Session: 
1. Run Xbrowser. 
2. Right-click on a session. 
3. Select [Properties]. Session Properties dialog box is displayed.  
4. Click [X Server] tab.  
5. Select a profile from [Server Profile] list.  
6. Click [OK].  

XDMCP Session Properties 
The following are descriptions of connection-related items in the XDMCP Session Properties. 
The items are displayed in the [General] tab of XDMCP Session Properties dialog box.  

Method 
The session connection methods are None (Passive), XDMCP Query, XDMCP Broadcast, XDMCP 
Indirect and Secure XDMCP. 
For descriptions of each connection method, see ‘Static XDMCP Session’.  

Host 
Enter remote host name or IP address for connection.  
Check if a display manager is in operation in the remote host. Most UNIX/Linux use dtlogin, 
kdm, gdm, or xdm as the display manager. 

Port Number 
Enter remote display manager port number. The default value is UDP 177.  

Use Default 
Set port number as the UDP 177 default value.  

Local Address 
Select one of the user system IP addresses. This option is used only when user system has 
several IP addresses.  
If Auto Select is selected from the list, Xmanager finds an IP address appropriate for 
connection. If Xmanager fails to find an appropriate address, open IP Selector dialog box for 
a user to directly select an address.  
Display manager on a remote host will connect to the IP address selected by a user. If an 
inappropriate IP address is selected, display manager cannot connect to Xmanager and login 
screen cannot be displayed.  

Connection Address  
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This option is necessary when you connect using port forwarding in a limited network 
environment such as firewall or proxy server and when automatic connection address does not 
function properly due to XDM server settings even if Secure XDMCP connection is selected. 
When your Windows resides in a private network with a firewall, Xmanager cannot get a 
remote login window with an XDMCP connection. It is because that the firewall blocks incoming 
connections and the remote display manager cannot reach at Xmanager on your Windows. To 
use this feature, you need to allocate a listening port in the firewall and forward incoming 
connections to your Windows.  

Address Type 
Select User Defined when using a proxy server or attempting XDMCP connection in an 
environment blocked by a firewall. In case of Secure XDMCP, if Automatic of connection 
address fails, select IP address of SSH server or Loopback Address (127.0.0.1).  

IP Address 
If [Address Type] is selected as User Defined, enter proxy server or firewall server IP 
address. The remote display manager attempts connection using this address and the 
proxy server forwards the connection to the user’s system.  

Port Number  
If [Address Type] is selected as User Defined, designate a TCP port number allocated to a 
proxy server and standing by for port forwarding.  
 

For example, let’s assume that a user’s computer uses 192.168.1.100, a private IP address, 
and firewall server uses 192.168.1.1, a private IP address. Additionally, the firewall uses 
210.100.xxx.10, a public IP address, for an external Internet connection, and the UNIX host IP 
address is 210.100.xxx.100.  
In this case, you need to configure the firewall to forward incoming connections 
(210.100.xxx.10, 6010) to Xmanager (192.168.1.100, 6010) on your Windows. This is called 
port forwarding. For this setting, make an inquiry to the firewall system administrator.  
Now, enter 210.100.xxx.100 in the [Host] box of [Connection] field, and select User Defined as 
[Address Type] in [Connection Address]. Then, enter 210.100.xxx.10 in [IP Address] and enter 
6010 in [Port Number]. Click [X Server] tab, clear [Allocate display number automatically] 
option and enter 10 (TCP 6010) in [Display Number].  
 

The [Connection Address] setting process when connecting 

with an external host through a router, is described in 

‘Connection with MIT Kerberos 
To authenticate with Kerberos using SSH, there are few things that needs to be set up 
beforehand. Xmanager 5 is tested with MIT Kerberos server version 5 and MIT Kerberos 
module for Windows. This article assumes that you have working Kerberos server and client. 
 
To create a new Kerberos session, 
1. Open Xstart and click New. 
2. Enter a host name in Host.  
3. Select SSH from Protocols list.  
4. For Authentication, select Kerberos (MIT Kerberos GSSAPI.dll). 
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5. Enter the user name. 
6. Click Save to save. 
7. Select the session file you just created and click Run. 
 
You have finished creating a session that will use the MIT kerberos module. When this session 
opens, it will try to use the Kerberos credential for the specified user. It has to be the same 
user you defined in the Network Identity Manager. 
Firewall-related Setting’. 

Xstart Session Properties 
The following are descriptions of connection-related items in Xstart session properties. The 
items are displayed in the [General] tab of Xstart session properties dialog box.  

Host 
Enter the remote UNIX/Linux host name or IP address. It is faster and more stable to enter an 
IP address than a host name, because Xstart does not have to connect to a name server. 

Protocol 
Select a protocol for remote host connection. Xstart supports SSH, TELNET, RSH, REXEC, 
RLOGIN and LOCAL protocols. Before selecting a protocol, be sure to check whether or not the 
remote host supports the protocol.  
SSH is a protocol for secure connection with remote host. SSH provides Public Key User 
Authentication, powerful data encryption and X11 forwarding functions. Using SSH protocol, a 
remote X application can be executed securely using the powerful encryption, even in a 
network environment vulnerable to security. Additionally, SSH helps you with convenient 
connection to a host located on the other side of a firewall. A user on a private network can 
thus run an X application on another network using X11 forwarding function.  
TELNET is a legacy protocol for using a remote terminal. It is supported by most servers, such 
as UNIX, Linux and VMS. 
RSH is a simple protocol for connecting with a remote host and running a designated 
command. It does not require a password and be careful in using it for security.  
REXEC is a protocol for running a command in a remote host. Although the functions are 
almost similar to those of RSH, REXEC requires a password for connection. 
RLOGIN is a simple program for connecting with a remote host and obtaining login shells. 
Although similar to TELNET, RLOGIN authenticates users in a similar method to RSH.  
LOCAL is for running an X application installed in a user’s PC, not a remote host. 

 Note 

For RSH, REXEC and RLOGIN, the latest UNIX/Linux versions do not permit connection with 
the default configurations.  

Setup 
Open the Protocol Setup dialog box in relation to the protocol selected and set connection 
port, timeout and options by protocol. 

User Name 
Enter remote host user account. 

Execution Command 
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Enter a command to be executed in a remote host.  
For example, if a user executes xterm, the execution command is as follows: 

/usr/bin/X11/xterm –display $DISPLAY 

The “$DISPLAY” variable is converted to an appropriate value by Xstart. In general, it is 
converted to “192.168.1.100:0.0” when the IP address of your Windows is “192.168.1.100”. To 
designate the value directly, the following command is executed: 

/usr/bin/X11/xterm –display 192.168.1.100:0.0 

Additionally, ‘$PCADDR’ variable and ‘$DISPNO’ variable can be converted. In this case, the 
execution command is as follows. 

/usr/bin/X11/xterm –display $PCADDR:$DISPNO 

If a user’s PC uses several IP addresses, Xstart automatically changes them to appropriate 
values. 

Registered Command (Direction Key Button)  
Click this button to select a predefined command on a menu. By selecting a command on the 
menu, you can enter a long command just with a single click. 
Select [Add/Remove] to display Registered Commands dialog box. In the dialog box, register 
the frequently used commands. 

Show connection status window  
Select this option to check connection status or messages transferred from a remote host. This 
option is useful when Xstart fails to run an X application. 

SSH Protocol Setting 
Set the following SSH-related options for an Xstart session or a Secure XDMCP session for 
which SSH protocol is selected.  

 Note 

To set an SSH protocol, designate protocol as SSH in the ‘Xstart Session Properties’ 
[General] tab and click [Setup]. Alternatively, designate method as Secure XDMCP in the 
‘XDMCP Session Properties’ [General] tab and click [Setup].  

The SSH server host is different from the XDMCP server 
Secure XDMCP is a connection method that X clients connects to Xmanager of PC through 
SSH tunneling. If SSH server is not running on XDM host server, a proxy server for SSH 
tunneling is required. This option is to configure this SSH proxy server.  

Host 
Enter host name or IP address of the proxy server for SSH tunneling. In this case, you 
need to configure SSH proxy server so that it can bind to not only loopback address 
(127.0.0.1) but also external connections.  

Preferred Version 
Select an SSH protocol version to use. SSH2 is recommended since it provides better security 
and more functionalities than SSH1. 

Port Number 
Enter port number to use in SSH connection. 

Use Default 
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Set [Port Number] as 22, the SSH protocol default port. 

Send keep alive signal 
Send keep alive signal to a remote host. This function is used to prevent disconnection while a 
user is temporarily absent. In some network environments, a gateway or a firewall system may 
terminate connections without notice when the connection is idle for a specified period of time. 

Encryption 
Encryption algorithms are used to encrypt and decrypt network traffics. Users can select their 
preferred algorithms from the list. If <Cipher List> is selected, several algorithms can be tried 
in order of preference. To modify <Cipher List>, click [Edit].  

MAC  
MAC(Message Authentication Code) ensures that data transferred through a network is not 
changed by a third person. It provides increased security of SSH2 protocol over SSH1. Users 
can select their preferred MAC algorithms from a list. If <MAC List> is selected, several 
algorithms can be tried in order of preference. To modify <MAC List>, click [Edit].  

Compress network data(using ZLIB compression) 
Select this option to compress all data traffic with the ZLIB algorithm. Compression will provide 
better performance in a slow network environment.  

Allocate a terminal before executing the command 
This option is selected when you want to allocate a virtual terminal on the remote host and 
then run a command on the terminal. Virtual terminals are required by several X applications. 
When virtual terminals are allocated, shell environment variables are set as per the general 
login envirorment.  

TCP/IP Forwarding 
In [Tunneling] tab, you can list, add and delete TCP/ IP forwarding channels in a session.  

Xbrowser Window Setting 
Xbrowser is similar to Explorer and consists of menus, standard buttons, an address bar, 
workspace and a status bar.  
Workspace consists of a session category tree and icons list. Session category includes XDMCP 
session, Xstart session, Xshell session and Xftp session.  
An option to show or hide Xshell and Xftp sessions is provided in the Options dialog box 
[Sessions] tab. Additionally, XDMCP session folder and Xstart session folder can be designated. 
When several users designate a network folder as a session path, all users can use the same 
sessions. 

To Change Session Path: 
1. Run Xbrowser. 
2. Select [Options] in [Tools] menu. Options dialog box is displayed.  
3. Click [Sessions] tab.  
4. Enter a session folder to change in [XDMCP Sessions] or [Xstart Sessions].  

 Note 

To restore the original session path, click [Restore Default Session Path].  
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Column Setting 
The Columns dialog box allows you to adjust the columns of Xbrowser when it is in [Details] 
view.  

To Change Column Information: 
1. Run Xbrowser. 
2. Select [Columns] from [View] menu. Columns dialog box is displayed.  
3. Select or unselect a column to show or hide.  

Create Session Folder 
Users can connect all sessions at once by managing sessions with a folder. Additionally, Using 
session folder, session management, such as deletion and categorization, can be conveniently 
achieved.  

To Create a New Session Folder: 
1. Run Xbrowser. 
2. Point to [New] in the [File] menu and select [Folder]. 
3. Enter folder name. 

Export 
Exported sessions are saved into a single convenient file. When this file is imported from 
another computer where Xmanager is installed, the imported sessions may be used without 
additional setup.  

To Export Sessions: 
1. Run Xbrowser. 
2. Select [Export] from the [File] menu. The Import/Export Sessions wizard is displayed. 
3. Select a product for which to export sessions and click [Next].  
4. Select a location to save the exported sessions file and click [Next]. Sessions export 

results displayed.  
5. Click [Finish] to complete sessions export.  

Import 
Xmanager can import previous version sessions or files exported by other computers.  

To Import Sessions: 
To import sessions from the previous version program installed in the same computer: 
1. Run Xbrowser. 
2. Select [Import] from the [File] menu. The Import/Export Sessions wizard is displayed. 
3. Select [Import the session of previous version] and click [Next]. List of previous version 

products installed in the computer and sessions counts are displayed.  
4. Select a product for which to import sessions and click [Next]. Sessions are imported and 

the result is displayed.  
5. Click [Finish] to complete sessions import.  
 
To import sessions from a exported file: 
1. Run Xbrowser. 
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2. Select [Import] from the [File] menu. The Import/Export Sessions wizard is displayed. 
3. Select [Source location]. 
4. Directly enter file location or click […] to select a sessions file.  
5. Click [next] to move to the next stage. Products included in the file and sessions counts 

are displayed.  
6. Select a product for which to import a session and click [Next]. Sessions are imported and 

the result is displayed.  
7. Click [Finish] to complete session import.  
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Connection 
Xmanager provides Xbrowser and Xstart for connection to a remote host. In general, 
Xbrowser is used for connection to a remote host using XDMCP protocols. Xstart is used 
when running X applications in a remote host one by one.  

Connect with Xbrowser 
Xbrowser broadcasts an XDMCP query message to a local network or a designated host and 
automatically displays hosts that respond to the query message.  

To Connect to XDMCP Host: 
1. Run Xbrowser. Hosts available for connection are displayed. 

 Note 

To list up hosts available for connection on local network, the [Search for local hosts 
(XDMCP Broadcast)] option must be turned on. For settings on local host search, see 
‘Automatic XDMCP Session’. 

2. Double-click a host for connection. Xmanager is run and the host is connected with 
XDMCP protocol. 

 Note 

To refresh the list of hosts available for XDMCP connection, click [View] -> [Find Hosts].  

To Connect to Host in Address Bar: 
1. Run Xbrowser. 
2. Enter host name or IP address for connection in the address bar.  
3. Press Enter key. 

 Note 

For details on address bar, see ‘Xbrowser Address Bar’. 
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Xbrowser Address Bar 
The rules for addresses entered in address bar are outlined as follows. 

 hostname (or ipaddress) 

 xdmcp://hostname 

xstart://sessionname 

xsession://sessionname 

ssh://[username[:password]@]hostname[:port][/] 

telnet://[username[:password]@]hostname[:port][/] 

rlogin://[username[:password]@]hostname[:port][/] 

ftp://[username[:password]@]hostname[:port][/] 

sftp://[username[:password]@]hostname[:port][/] 

The usable protocols are xdmcp, xstart, xsession, ssh, telnet, rlogin, ftp and sftp. The xdmcp 
protocol is used as the default protocol when no protocol is designated. The xdmcp protocol 
uses UDP 177 port as the default port.  
Refer to the examples that follow: 

Example Description 

foobar.com 
xdmcp://foobar.com 

Connect to foobar.com using XDMCP protocol.  

xstart://mysession Run an Xstart session named mysession. 
xsession://cdesession Run a static session named cdesession. 
ssh://myhost:22/ Run Xshell and connect to myhost port 22 using an SSH 

protocol. To run this command, Xshell program must be 
installed in the computer.  

telnet://user:pass@myhost Run Xshell and connects to myhost using a TELNET 
protocol. User name and password are automatically 
transferred after connection. To run this command, Xshell 
program must be installed in the computer.  

rlogin://user@myhost Run Xshell and connect to myhost using an RLOGIN 
protocol. User name is automatically transferred after 
connection. To run this command, Xshell program must be 
installed in the computer.  

ftp://anonymous@myhost Run Xftp and connect to myhost using an FTP protocol. 
User name is automatically transferred after connection. To 
run this command, Xftp program must be installed in the 
computer.  

sftp://user:pass@myhost/ Run Xftp and connect to myhost port 22 using an SFTP 
(secure shell fire transfer protocol). User name and 
password are automatically transferred after connection. To 
run this command, Xftp program must be installed in the 
computer.  

Secure XDMCP Connection 
Using Secure XDMCP connection, a safer and simpler XDMCP connection is possible using SSH 
protocols. SSH protocols enable not only secure connection but also convenient X11 connection, 
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in network environments blocked by a firewall, a masquerade server or an NAT gateway.  
To use Secure XDMCP, an SSH server must be in operation on a remote server and X11 
forwarding function must be activated.  
For an OpenSSH server, modify setup file (/etc/ssh/sshd_config) as follows.  

X11Forwarding yes 
For a Secure Shell Communications Security server, modify setup file (/etc/ssh2/sshd2_config) 
as follows.  

AllowX11Forwarding yes 

To Create Secure XDMCP Session: 
1. Run Xbrowser. 
2. Click [XDMCP Session] in [New].  
3. Select [Method] as Secure XDMCP in Session Properties dialog box and enter 

information necessary in connection.  

 Note 

If a host to connect is seen in the list of XDMCP sessions, you can create a Secure XDMCP 
session by selecting [Save as SSH Connection] in the context menu. 

To Set Secure XDMCP Session in Case XDMCP Host is Different from SSH Server:  
1. Select [Properties] from the context menu of the XDMCP session concerned. Session 

Properties dialog box is displayed.  
2. While [Method] is selected as Secure XDMCP, click [Setup] on the right. Secure XDMCP 

Setup dialog box is displayed.  
3. Activate [Host] by selecting [The SSH server host is different from the XDMCP server]. 
4. Enter SSH server host name or IP address in [Host].  
5. Enter user information in [User Authentication] field.  
6. Click [OK] to save.  

 Note 

If SSH server is different from XDMCP host, enter the SSH server host name or IP address 
for tunneling. In this case, you need to configure SSH proxy server so that it can bind to 
not only loopback address (127.0.0.1), but also external connections. For OpenSSH, set 
the GatewayPorts value to yes in the SSH server setup file.  

To Connect with Secure XDMCP Session: 
1. Run Xbrowser. 
2. Double-click the Secure XDMCP session.  

Connect with Xstart 
Xstart supports SSH, TELNET, RLOGIN, REXEC, RSH and LOCAL protocols. To use each 
protocol, the corresponding service daemon must be executed in a remote host. LOCAL 
protocol is used when an X application is in the user’s PC.  

To Run X Application with SSH Protocol: 
1. Run Xstart. 
2. Click [New]. New Session dialog box is displayed. 
3. Enter new session name and click [OK].  
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4. Enter remote UNIX/Linux host name or IP address in [Host]. 
5. Select SSH from [Protocol] list. 
6. Click [Setup] to set SSH protocol options, such as port number or encryption options.  

 Note 

For details on SSH Protocol Setting, see ‘SSH Protocol Setting’. 

7. Enter remote host user account name in [User Name]. 
8. Select an authentication method in [Authentication] and set password, etc.  

 Note 

For details on setting according to authentication methods, see ‘Xstart User Authentication 
Setting’. 

9. Enter a command to run in the remote host in [Command]. To run xterm, enter a 
command as follows: 
/usr/bin/X11/xterm –ls 

 Note 

For SSH connection, DISPLAY variables are automatically set with the values decided by 
the SSH server.  

10.  Click [Run]. 

To Run Remote X Application with TELNET Protocol: 
1. Run Xstart. 
2. Click [New]. New Session dialog box is displayed. 
3. Enter a new session name and click [OK].  
4. Enter remote UNIX/Linux host name or IP address in [Host]. 
5. Select TELNET from [Protocol] list. 
6. Click [Setup] to set TELNET protocol options, such as port or timeout.  

 Note 

The connection method for RLOGIN, REXEC and RSH protocols is similar to connection with 
TELNET protocols. Set port and timeout in Protocol Setup dialog box.  
The default port numbers in each protocol are outlined as follows 
TELNET:  23 
REXEC:  512 
RLOGIN:  513 
RSH:  514 

After a successful login, a shell is allocated by TELNET and RLOGIN server in a remote host 
and Xstart executes the command in the shell prompt. Xstart closes connection after the 
designated timeout and the login shell is ended at the same time. If timeout is 0, 
connection is not closed while Xmanager is in execution. If a shell is closed earlier, X 
applications executed on the shell may also be ended.  

7. Enter remote host user account in [User Name]. 
8. Only Password can be selected in [Authentication]. Click [Setup] to enter password.  
9. Enter a command to be executed in a remote host in [Command]. To run xterm, enter a 
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command as follows: 
/usr/bin/X11/xterm –ls –display $DISPLAY 

10.  Click [Run]. 

To Run Local X Application with Xstart: 
1. Run Xstart. 
2. Click [New]. New Session dialog box is displayed. 
3. Enter a new session name and click [OK]. 
4. Select LOCAL from the [Protocol] list. 
5. Enter overall local command path in [Command].  
6. Click [Run]. 

Xstart User Authentication Setting 

To Set Password: 
1. Run Xstart. 
2. Select Password in [Authentication] and click [Setup]. Password Setup dialog box is 

displayed. 
3. Enter password.  
4. Select [Save password] and click [OK] to save the entered password in session.  
5. To remove password, click [Reset password].  

To Set Public Key: 
1. Run Xstart. 
2. Select Public Key in [Authentication] and click [Setup]. Public Key Authentication 

Setup dialog box is displayed.  
3. Select a user key to use in authentication.  
4. Enter passphrase.  

 Note 

For details on public key setting, see ‘Public Key User Authentication’. 

For security, directly enter a passphrase at each connection without saving it in a session. 
In this case, ‘SSH User Authentication Dialog Box’ asking for passphrase is displayed at 
connection.  

Xstart Command Tag Definition 
Xstart provides a command tag function to automate repetitive commands. Command tags 
are entered in [Command].  
 

Tag Description 

<%CR%> Send CR (Carriage Return, \r) character. 
<%LF%> Send LF (Line Feed, \n) character. 
<%SEND=”string”%> Send a character string. Xstart does not convert 

DISPLAY and PCADDR variables in the character string. 
<%WAIT=”string1|string2”%> Stand by for string1 or string2. 
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Tag Description 

<%SLEEP=n%> Sleep for n seconds. 
<%POPUP=”string”%> Open Remote execution result window if a designated 

character string is received.  

All tags are processed in sequence except for the POPUP tag which is valid till the command is 
completed entirely.  

 Note 

Command tags are supported by TELNET and RLOGIN protocols. To use this function in an 
SSH protocol, select [Allocate a terminal before executing the command] in the [Options] 
tab of SSH Protocol Setup dialog box. When terminal is allocated, shell environment 
variables are set as per general login environment.  

Example 
1. The following command is an example of a multi-login. Log in to a host with Xstart, 

and connect to another host using telnet and run xterm: 
 
telnet host2<%CR%><%WAIT=”login:”%>root<%CR%> 
<%WAIT=”Password:”%>password<%CR%><%WAIT=”$”%>xterm –ls –display 
$DISPLAY 
 

2. The following command is an example of the display Remote execution result 
window when a character string ”assword:” is displayed. This command is useful 
when password expires in a fixed cycle and a new password must be entered before a 
command line prompt is displayed: 
 
<%POPUP=”assword:”%>xterm –ls –display $DISPLAY 

Connection with MIT Kerberos 
To authenticate with Kerberos using SSH, there are few things that needs to be set up 
beforehand. Xmanager 5 is tested with MIT Kerberos server version 5 and MIT Kerberos 
module for Windows. This article assumes that you have working Kerberos server and client. 
 
To create a new Kerberos session, 
8. Open Xstart and click New. 
9. Enter a host name in Host.  
10. Select SSH from Protocols list.  
11. For Authentication, select Kerberos (MIT Kerberos GSSAPI.dll). 
12. Enter the user name. 
13. Click Save to save. 
14. Select the session file you just created and click Run. 
 
You have finished creating a session that will use the MIT kerberos module. When this session 
opens, it will try to use the Kerberos credential for the specified user. It has to be the same 
user you defined in the Network Identity Manager. 

Firewall-related Setting 
Special settings are required if a remote host is in another network on the opposite side of a 
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gateway or there is a firewall in between user’s PC and a remote host because Xmanager is a 
server program and remote X applications connect to Xmanager in a user’s PC.  
The keep alive option to retain connection, which is supported by SSH protocols, is useful when 
a firewall forcefully ends a connection that is idle for a set period of time.  
Port-forwarding is required for XDMCP connections when you are in a private network and you 
connect to a remote host over a router. Once you have configured port-forwarding on the 
router, you should configure connection address for XDMCP connections. 

To Use Keep Alive Option for SSH Connection in Firewall Environment: 
1. Run Xstart. 
2. Select a session from the [Session] list. 
3. Select SSH from the [Protocol] list. 
4. Click [Setup]. SSH Protocol Setup dialog box is displayed. 
5. Click the [General] tab. 
6. Select [Send keep alive signal]. 
7. Click [OK]. 

To Set Router Port Forwarding: 
1. Connect to a router and move to port forwarding setup page.  
2. Forward external router ports TCP 6000 ~ 6010 to the 6000 ~ 6010 ports in the user PC. 

If the user PC IP address is 192.168.1.2: 
Router Port  PC Port Address 
6000  6000 192.168.1.2 
6001  6001 192.168.1.2 
… 
6010  6010 192.168.1.2 

 Note 
Router port number does not need to be the same as PC port number. However, X 
applications attempt connection with the IP address and the corresponding router port. 
Since router forwards packets to a PC port according to the port forwarding rules, the 
display number designated in Xmanager sessions files must be the same as the port 
designated in router port forwarding rules. Xmanager display number added with 6000 
becomes the port number.  

3. Save settings.  
4. In Xstart session, values relating to –display options must be designated as display 

numbers relevant to the router IP address and port number of the PC designated in the 
router port forwarding setting. For XDMCP session, [Connection Address] must be set.  

 Note 

For port forwarding setting, see router manual. 

To Set XDMCP Session Connection Address: 
1. Run Xbrowser. 
2. Right-click on a session for which to set connection address.  
3. Select [Properties].  
4. Click the [General] tab.  
5. Select User Defined as [Address Type] in the [Connection Address] field.  
6. Enter router IP address in the [Connection Address] field [IP Address] box.  
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7. Enter a port designated in the router port forwarding setting in of the [Connection Address] 

field [Port Number] box.  

 Note 

The port number is a router side port number which is configured to perform port-
forwarding from router to PC. 

8. Click the [X Server] tab. 
9. Unselect [Allocate display number automatically] in the [Display Number] field.  
10. Enter a display number in [Display Number] relevant to the port number of the PC 

designated in the router port forwarding setting.  

 Note 

The display number is from the PC port number designated for forwarding from the router 
to a PC. The port number minus 6000 is the display number.  

11. Click [OK]. 

Solve Connection Problem 
Even if the steps listed above are followed, connection with a remote host may not be 
successful according to user environments. This section briefly introduces the methods to solve 
connection-related problems.  

To Solve XDMCP Connection Problem: 
1. Check the following: 

• Is any of dtlogin, kdm, gdm, or xdm being executed in a remote host?  
• Is a login window displayed?  
• Is the remote host in another network?  
• Is there a firewall in between remote host and user’s PC?  
• Is a firewall set in user’s PC?  
• User’s PC address may be incorrectly set in name server.  
• DISPLAY variables may be configured in the user account shell script.  

2. Refer to log message. 
• To view an Xmanager log file, point to [Log] in the Xmanager main window system 

menu and select [File].  
• If login screen is not displayed in CDE environment, check /var/dt/Xerrors file. If login 

fails, check $HOME/.dt/startlog and $HOME/.dt/errorlog files. 

 Note 

For details on log file, see ‘Session Log’. 

To Solve Xstart Connection Problems: 
1. Run Xstart. 
2. Select [Show connection status window]. 
3. Click [Run]. Xrcmd: Remote execution result window opens. 
4. Read message and identify causes of the problem. 

 Note 
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Remote execution result window is a message window showing the connection progress 
status. A simple command input is possible. However, there are many restrictions in 
performing tasks, such as terminal emulation. This window only shows the process until a 
program including an execution command starts, which is the Xstart objective. 

Xmanager Command Line Options  
Xmanager supports command line options to interface with other user applications. When a 
user directly executes Xmanager, the connection methods and display numbers must be 
designated as options. 
The Xmanager command line rules are as follows: 
Xmanager [-query hostname|-broadcast|-indirect hostname] [:digit] 

 

Command Description 
Xmanager Run in passive mode using [Default Xstart Profile]. 

Display number is set as 0, the default value. If it is 
not available, another value is automatically 
allocated. 

Xmanager :1 Run in passive mode using [Default Xstart Profile]. 
Display number is set as 1. If it is not available, 
execution is stopped.  

Xmanager –query host Connect to a designated host using XDMCP Query 
connection method. [Default XDMCP Profile] is used. 
Display number is set as 0, the default value. If it is 
not available, another value is automatically 
allocated.  

Xmanager –query host :2 Connect to a designated host using XDMCP Query 
connection method. [Default XDMCP Profile] is used. 
Display number is set as 2. If it is not available, 
execution is stopped. 

Xmanager –broadcast Display XDMCP hosts available for connection in 
Chooser dialog box by forwarding XDMCP Broadcast 
messages to local network. [Default XDMCP Profile] 
is used. Display number is set as 0, the default value. 
If it is not available, another value is automatically 
allocated.  

Xmanager –indirect host Connect to a host using XDMCP Indirect connection 
method. Remote host opens Chooser window through 
Xmanager. [Default XDMCP Profile] is used. Display 
number is set as 0, the default value. If it is not 
available, another value is automatically allocated.  
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Xrcmd Command Line Options 
Xstart provides command line option, which enables advanced users to integrate the program 
with their applications. In reality, Xstart only provides a user interface for sessions creation 
and management. When a user opens a session using Xstart, it executes Xrcmd.exe 
command and forwards the session information. For direct connection, Xrcmd.exe, must 
therefore be used, not Xstart. Xrcmd is found in a folder where Xmanager is installed. 

The Xrcmd Command Line Rules are As Follows: 
Xrcmd –protocol ssh|telnet|rexec|rsh|rlogin|local –host hostname 

[–user username] [-password password] [-userkey keyname] 

[-passphrase userkeypass] [-shell] [-zlib] [-status] 

[-result] [-dispno nnn] [-timeout nnn] [-port nnn] 

-command remote_command 

Note: –command option must be at the end. 

Options: 
Tag Description 

-protocol protocol Designate a connection protocol. 
-host hostname Designate a remote host.  
-user username Designate remote host user account. 
-password xxxx Designate user account password. 
-userkey keyname Designate user key name. This option is used only for 

SSH connection. 
-passphrase userkeypass Enter user key passphrase. This option is used only for 

SSH connection. 
-shell Run a command after shell (terminal) starts. This option 

is applied only to SSH connection.  
-zlib Compress network data using zlib algorithm. This option 

is applied only to SSH connection.  
-status, -result Show Remote execution result window.  
-dispno nnn Designate a display number to be used by Xmanager. If 

this option is not set, Xmanager automatically allocates 
an appropriate value.  

-timeout nnn Close connection after nnn seconds. 
-port nnn Designate connection protocol port number. If this option 

is not set, the default protocol port number is used.  
-command command Designate a command to be executed in a remote host. 

Ex.: 
Xrcmd –protocol telnet –host mylinux –user myname –status 

–command /usr/bin/X11/xterm –ls 

Xrcmd connects to mylinux using a telnet protocol and logs in with myname. Then, it executes 
xterm command on a remote host. Connection status can be checked through Remote 
execution result window during the course of connection.   
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Server Profile Setting 
Server profile contains Xmanager options, such as window modes, fonts, colors and security 
options.  

Xconfig shows all Xmanager profile icons available for use. Users can designate a profile on 
XDMCP session or Xstart session.  
The shared profile is displayed with a hand-shaped icon and can be modified only by users with 
system administrator permissions. For the default XDMCP profile or the default Xstart profile, 
the icon is marked with black ticks on top. Double-click icon to modify the properties of each 
profile.  

Profile Management 
When a user creates a session, the default profile is designated to the session. As default 
profiles, Xmanager supports the default Xstart profile and the default XDMCP profile. Default 
Xstart profile is applied when [Server Profile] is set as Auto Select in a Xstart session. Default 
XDMCP profile is applied when [Server Profile] is set as Auto Select in a XDMCP session. All 
automatic XDMCP sessions use the default XDMCP profile.  

To Create Server Profile: 
1. Run Xconfig. 
2. Select [New] from the [File] menu. A new profile is created in the Xconfig window. 
3. Double-click the new profile. Profile properties dialog box is displayed. 
4. Set options.  
5. Click [OK].  

To Set Default Xstart Profile: 
1. Run Xconfig. 
2. Right-click on a profile to be used as default Xstart profile.  
3. Select [Set as default Xstart profile].  

To Set Default XDMCP Profile:  
4. Run Xconfig. 
5. Right-click on a profile to be used as default XDMCP profile.  
6. Select [Set as default XDMCP profile].  

To Share Profile with Other Users: 
1. Run Xconfig. 
2. Right-click on a profile to share with other users. 
3. Select [Sharing]. A hand-shaped icon is added to the server profile icon.  

To Send Profile to Another User through E-mail: 
1. Run Xconfig. 
2. Right-click on a profile. 
3. Point to [Send To] and select [E-Mail Recipient]. E-mail Editor opens with the profile 

attached.  

To Export Profile to Folder: 
1. Run Xconfig. 
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2. Drag a profile and drop it in an external folder. 

To Import Profile to Xconfig: 
1. Run Xconfig. 
2. Drag a profile from an external folder and drop it in Xconfig. 

Window Mode 
Xmanager supports Single Window Mode mainly used in XDMCP sessions and Multiple Window 
Mode mainly used in Xstart sessions. In Single Window Mode, you can customize the size of 
the root window and add a scroll bar when the X desktop is larger than your Windows desktop.  
In Multiple Window Mode, you can select a window manager and the desktop background. 
Additionally, you can set panning and auto-raise function to activate a window on mouse focus.  

 Note 
In Single Window Mode, Xmanager opens one large main window. Users can open the 
system menu by clicking Xmanager icon in the title bar.  

In Multiple Window Mode, Xmanager icon is created in the notification area. To use 
Xmanager system menu, right-click on the icon in the notification area.  

To Use Xmanager in Single Window Mode: 
1. Run Xconfig. 
2. Double-click a profile. Profile Properties dialog box is displayed. 
3. Click the [General] tab.  
4. Select Single Window Mode from the [Window Mode] list.  
5. Click [OK].  

To Set Root Window Size in Single Window Mode: 
1. Run Xconfig. 
2. Double-click a profile. Profile Properties dialog box is displayed.  
3. Click the [General] tab.  
4. Select Single Window Mode from the [Window Mode] list. 
5. Click [Settings]. Window Mode Settings dialog box is displayed.  
6. Click the [Single Window Mode] tab.  
7. Select an appropriate size from the [Window Size] list.  
8. Click [OK].  

 Note 
As for Desktop Size, run Xmanager as large as the desktop excluding task bar. 

For Full Screen, run Xmanager as large as the entire screen without title bar and window 
frame. Windows task bar is also not displayed.  

To Use Multiple Window Mode: 
1. Run Xconfig. 
2. Double-click a profile. Profile Properties dialog box is displayed.  
3. Click the [General] tab. 
4. Select Multiple Window Mode from the [Window Mode] list.  
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5. Click [OK].  

To Use Panning in Multiple Window Mode: 
1. Run Xconfig. 
2. Double-click a profile. Profile Properties dialog box is displayed.  
3. Click the [General] tab. 
4. Select Multiple Window Mode from the [Window Mode] list. 
5. Click [Settings]. Window Mode Settings dialog box is displayed.  
6. Click the [Multiple Window Mode] tab. 
7. Select [Use Panning]. 
8. Click [Panning Settings] to set panning options.  
9. Set velocity and position in Panning Settings dialog box.  
10. Click [OK].  

 Note 
The panning can be used only when local window manager is used.  

This option is useful when the window size is larger than the desktop and some window 
areas are located outside the desktop. Each time mouse pointer moves on a panning 
position, panning window moves inside the desktop area by pixels designated in panning 
velocity. 

To Use Auto-Raise in Multiple Window Mode: 
1. Run Xconfig. 
2. Double-click a profile: Profile Properties dialog box is displayed.  
3. Click the [General] tab. 
4. Select Multiple Window Mode from the [Window Mode] list. 
5. Click [Settings]. Window Mode Settings dialog box is displayed.  
6. Click the [Multiple Window Mode] tab. 
7. Select [Raise Window Automatically]. 
8. Click [OK]. 

To Select Background in Multiple Window Mode: 
1. Run Xconfig. 
2. Double-click a profile: Profile properties dialog box is displayed.  
3. Click the [General] tab. 
4. Select Multiple Window Mode from the [Window Mode] list. 
5. Click [Settings]. Window Mode Settings dialog box is displayed.  
6. Click the [Multiple Window Mode] tab. 
7. Select Background from the [Background] list. 
8. Click [OK]. 

 Note 
For Windows Background, the background is managed by Windows. In this mode, X root 
window background cannot be used. 

For X Window Background, the background is managed by Xmanager. The background 
changes to the X root window and the mouse pointer changes to an X pointer. In this mode, 
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Windows icons in the desktop cannot be used.  

X Window Background(Transparent) operates the same as X Window Background mode. It 
looks like Windows Background and you can still see the Windows icons on the desktop, 
but those icons are not active. 

To Select Window Manager in Multiple Window Mode: 
1. Run Xconfig. 
2. Double-click a profile: Profile Properties dialog box is displayed.  
3. Click the [General] tab. 
4. Select Multiple Window Mode from the [Window Mode] list. 
5. Click [Settings]. Window Mode Settings dialog box is displayed.  
6. Click the [Multiple Window Mode] tab. 
7. Select a window manager from the [Window Manager] list.  
8. Click [OK].  

 Note 
Window manager manages X applications. It adds a title bar, a frame and system menu to 
the window. Additionally, it provides functions to change window size, to move window and 
to close window. Local window manager looks like Windows and adds a title bar and a 
frame to an X application just like Windows applications. Remote window manager, such as 
dtwm, mwm and fvwm, is executed on a remote host and looks different from local window 
manager.  

Xmanager provides Automatic Switch, Remote Only, and Local Only for the window 
manager mode. 

In Automatic Switch mode, window manager is automatically converted. At the beginning, 
Xmanager runs a local window manager, and when a remote window manager tries to 
connect to Xmanager, the local window manager is automatically closed. And if the remote 
window manager is closed by user, the local window manager will run again.  

In Remote Only mode, local window manager is not executed. Run remote window 
manager to manage X application windows.  

In Local Only mode, connection by remote window manager is not permitted. All X 
application windows are managed in the same way as Windows applications.  

Connection Option Setting 
The keep alive function is useful when connection is unexpectedly closed while connection is 
idle. In some network environments, gateway or firewall system forcefully disconnects with 
system in case data transfer is not made for a set period of time.  
Automatic closing function is to automatically close Xmanager in case user input is not made 
for a set period of time.  

To Retain Connection: 
1. Select [Send TCP keepalive packets when network is idle].  
2. Enter waiting time (seconds) in idle state in [Timeout].  
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To Set Automatic Closing: 
1. Select [Close session when user is idle].  
2. Enter waiting time (minutes) in idle state in [Timeout].  

 Note 

When Xmanager closes due to automatic closing setting, all X applications may end 
unexpectedly and work data may be lost. 

Font Management 
Xmanager provides fonts necessary in most systems and applications. However, users may 
need to directly add new fonts.  

To Download and Install Additional Fonts Pack: 
1. Go to Xmanager download page using the address following: 

http://www.netsarang.com/download/font.html 
2. Download additional fonts pack to install.  
3. Run the fonts pack in user’s system.  
4. Install fonts pack according to the instructions provided by install wizard.  

 Note 

When additional fonts pack is installed, a fonts folder is automatically added to all server 
profiles, so a new fonts folder does not need to be registered separately in each server 
profile when using Xconfig.  

To Change BDF Font to PCF Font: 
1. Run bdftopcf.exe program as in the following example: 
C:\tmp> %XMANAGER_INSTALL_DIR%\bdftopcf new.bdf –o new.pcf 

To Create or Renew FONTS.DIR File Using Mkfntdir.exe Program: 
1. Move to fonts folder and run mkfntdir.exe program: 
%XMANAGER_INSTALL_DIR%\Fonts\NewFonts> ..\..\mkfntdir 

To Create and Use Fonts Folder: 
1. Create a new folder below the following folder: 
%XMANAGER_INSTALL_DIR%\Fonts 

2. Copy new fonts files to the created folder. 
3. Run mkfntdir.exe program in the created folder: 
%XMANAGER_INSTALL_DIR%\Fonts\NewFonts> ..\..\mkfntdir 

4. Run Xconfig. 
5. Double-click a profile to which the new fonts folder is to be added. Profile Properties 

dialog box is displayed.  
6. Click the [Font] tab. 
7. Click [Add Font Folder]. Browse For Folder dialog box is displayed.  
8. Select a new font folder. 
9. Click [OK]. 
10. Restart Xmanager. 
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To Use Font Server: 
1. Run Xconfig. 
2. Double-click a profile. Profile Properties dialog box is displayed. 
3. Click the [Font] tab.  
4. Click [Add Font Server]. Add Font Server dialog box is displayed.  
5. Enter the font server name or IP address in [Host].  
6. Enter the font server port number in [Port].  
7. Click [OK]. 

 Note 

Check if a font server is in execution on a remote server. In general, the font server 
program name is xfs and the default port number is 7100.  

To Change Default Font:  
1. Run Xconfig. 
2. Double-click a profile. Profile Properties dialog box is displayed.  
3. Click the [Font] tab.  
4. Enter the name of the font to use as the default font in [Default Font].  
5. Click [OK].  

 Note 

Default font is used when an X application does not designate a font for text display.  

To Replace a Font with another Font when the Font Cannot be Found: 
1. Run Xconfig. 
2. Double-click a profile. Profile Properties dialog box is displayed.  
3. Click the [Font] tab.  
4. Select [Automatic Font Substitution].  
5. Click [OK].  

To Display Font Error Dialog Box: 
1. Run Xconfig. 
2. Double-click a profile. Profile Properties dialog box is displayed.  
3. Click the [Font] tab.  
4. Select [Show Missing Font Dialog].  

 Note 
The missing font message is used to find a font when the font used by a remote X 
application is not available in Xmanager. The missing font information is always recorded in 
the Xmanager log. Even if a font is unavailable in Xmanager, the missing font message 
may not be displayed by some X applications. In this case, find the necessary fonts by 
referring to the log or error messages of the concerned X application. 

5. Click [OK]. 

Color Management 
Visual is a device-independent color system, defining Xmanager color format and numbers of 
colors supported. Xmanager supports PseudoColor, StaticColor, DirectColor, TrueColor, 
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GrayScale and StaticGray, the six visuals defined in X window standard.  
In PseudoColor visual, all X applications can only use 256 colors and thus application execution 
may fail due to inadequate numbers of colors. Use [Automatic Color Substitution(PseudoColor)] 
option to successfully run the application in case color palette is insufficient due to another 
program.  
Windows uses 20 system colors in 256-color mode to display title bars, window frames and 
icons. In some X applications, the whole 256-color palette is used to display the colors properly. 
In this case, Windows desktop and icons may blink. Select [Preserve System Colors (20 colors)] 
option to prevent this.  
Additionally, Xmanager provides RGB database, which is used to change color names to 
appropriate RGB values. Users can edit the database using text editor. 

To Change Default Server Visual: 
1. Run Xconfig. 
2. Double-click a profile. Profile Properties dialog box is displayed.  
3. Click the [Color] tab.  
4. Select an appropriate visual from the [Choose Default Visual] list.  
5. Click [OK].  

 Note 
If the default visual is set as Auto Detect, Xmanager selects an appropriate visual 
according to the video device. In 256-color (8 bit) mode, it is set as PseudoColor. In true 
color (16 bit or higher) mode, it is set as TrueColor. The default visual is used by X root 
window and most applications.  

To Support Exact StoreColor Request (PseudoColor): 
1. Run Xconfig. 
2. Double-click a profile. Profile Properties dialog box is displayed.  
3. Click the [Color] Tab.  
4. Select [Exact StoreColor (PseudoColor)].  
5. Click [OK].  

 Note 
When true color video device operates with PseudoColor visual, StoreColor request 
overloads and deteriorates overall performance. Xmanager provides an option to turn off 
Exact StoreColor. 

To Operate True Color Video Device with 256-color Visual: 
1. Run Xconfig. 
2. Double-click a profile. Profile Properties dialog box is displayed.  
3. Click the [Color] tab. 
4. Select PseudoColor from the [Choose Default Visual] list.  
5. Click the [Advanced] tab. 
6. Select [When Mapped] in [Backing Store]. 
7. Click [OK]. 

 Note 
Some old CAD programs operate in 256-color system thus the default visual must be changed 
to PseudoColor to ensure successful execution.  
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To Change to RGB Format in TrueColor Visual: 
1. Run Xconfig. 
2. Double-click a profile. Profile Properties dialog box is displayed.  
3. Click the [Color] tab.  
4. Select [RGB in Reverse Order(TrueColor)].  
5. Click [OK].  

 Note 
This function is useful when an X application requires a special RGB format.  

T Change or Edit RGB Color Database: 
1. Run Xconfig. 
2. Double-click a profile. Profile Properties dialog box is displayed.  
3. Click the [Color] tab.  
4. Click [Change] or [View] in the [Color Database] field.  
5. Click [OK].  

Keyboard Setting 
Users can create or edit a keyboard file, designate a shortcut key to change a keyboard file 
real-time and edit the keyboard file using keyboard editor. Xmanager provides keyboard files 
created in advance in relation to most languages and keyboards.Users can thus find and use a 
keyboard appropriate for their application. If an appropriate keyboard file cannot be found, a 
similar keyboard file can be selected and conveniently edited.  

To Add Keyboard File to Keyboards List: 
1. Run Xconfig. 
2. Double-click a profile. Profile Properties dialog box is displayed.  
3. Click the [Devices] tab. 
4. Click [Keyboard Settings]. Keyboard Settings dialog box is displayed. 
5. Click [Add]. Add Keyboard dialog box is displayed. 
6. Select a keyboard file. 
7. Click [OK]. 

To Set a Specific Keyboard as Default Keyboard: 
1. Run Xconfig. 
2. Double-click a profile. Profile Properties dialog box is displayed.  
3. Click the [Devices] tab.  
4. Click [Keyboard Settings]. Keyboard Settings dialog box is displayed. 
5. Select a keyboard to use as a default keyboard from [Keyboards List]. 
6. Click [Set as Default]. 
7. Click [OK]. 

To Change Keyboard File Real-time: 
1. Click Ctrl+Alt+K while running Xmanager. Keyboard Selector dialog box is displayed.  
2. Press ‘K’ key several times while pressing Ctrl+Alt to select a keyboard.  
3. Release all keys.  
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 Note 

Users may view only those keyboard files in the Keyboard Settings dialog box 
[Keyboards List].  

To Edit Keyboard File: 
1. Run Xconfig. 
2. Double-click a profile. Profile Properties dialog box is displayed.  
3. Click the [Devices] tab.  
4. Click [Keyboard Settings]. Keyboard Settings dialog box is displayed.  
5. Select a keyboard to edit from [Keyboards List].  
6. Click [Edit]. Keyboard Editor opens.  
7. Double-click a key to edit in keyboard layout. Edit Key dialog box is displayed.  

 Note 

In the Edit Key dialog box, change the key status and keysym.  

Repeat continuously generates a same key event when a user presses a key. This function 
is used in most keys with the exception of auxiliary keys, such as Shift, Alt and Control.  

Latch generates either a KeyPress or KeyRelease event when the key is pressed and then 
released. The key must be pressed and released twice to generate KeyPress and 
KeyRelease events. In general, this function is used for CapsLock key or NumLock key.  

In the [Keysym] field, Normal, Shift, ModeSwitch and Shift ModeSwitch keysyms are set to 
a key. 

Normal is used when pressing the key while pressing no other auxiliary keys.  

Shift is used when pressing the key while pressing Shift key.  

ModeSwitch is used when pressing the key while pressing ModeSwitch key.  

Shift ModeSwitch is used when pressing the key while simultaneously pressing Shift and 
ModeSwitch keys.  

To Create New Keyboard File: 
1. Open Keyboard Editor.  
2. Select [New] from the [File] menu. Select Keyboard Type dialog box is displayed.  
3. Select an appropriate keyboard type and click [OK].  

 Note 

In Select Keyboard Type dialog box, [Keyboard Type] list shows all keyboard types 
available to use in Xmanager. Each keyboard has different keyboard layouts and key counts. 
A keyboard type similar to that being used must be selected.  

4. Edit keyboard in the selected keyboard layout. 

Mouse Setting 
Xmanager provides 3-button emulation, scroll using mouse wheel and changing the middle 
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and right mouse buttons.  

To Use 2-button Mouse as 3-button Mouse: 
1. Run Xconfig. 
2. Double-click a profile. Profile Properties dialog box is displayed.  
3. Click the [Devices] tab.  
4. Click [Mouse Settings]. Mouse Settings dialog box is displayed.  
5. Select [Click the left and right buttons simultaneously].  
6. Adjust the time interval between the left and right buttons in [Click Speed].  
7. Click [OK].  

 Note 

In 3-button emulation mode, mouse operates as if the middle button is pressed when the 
left and right buttons are pressed simultaneously. Click speed is the standby time from the 
pressing of one button to the pressing of another.  

To Scroll in X Application Using Mouse Wheel: 
1. Run Xconfig. 
2. Double-click a profile. Profile Properties dialog box is displayed.  
3. Click the [Devices] tab.  
4. Click [Mouse Settings]. Mouse Settings dialog box is displayed.  
5. Select [Use Wheel Mouse].  
6. Click [OK].  

 Note 

For scrolling using a mouse wheel, button4 event is generated when scrolling up and 
button5 event is generated when scrolling down. Right-clicking may not be available in 
some X applications, such as CDE desktop.  

To Change Right and Middle Button Positions: 
1. Run Xconfig. 
2.  Double-click a profile. Profile Properties dialog box is displayed.  
3. Click the [Devices] tab.  
4. Click [Mouse Settings]. Mouse Settings dialog box is displayed.  
5. Select [Use Right Button as Middle Button].  
6. Click [OK].  

 Note 

Select this option if the middle button is used more frequently than the right button.  

To Use Color Mouse Pointer: 
7. Run Xconfig. 
8.  Double-click a profile. Profile Properties dialog box is displayed.  
9. Click the [Devices] tab.  
10. Click [Mouse Settings]. Mouse Settings dialog box is displayed.  
11. Select [Use Color at Mouse Pointer].  
12. Click [OK].  
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Sound Setting 
In Sound Settings dialog box, select bell types and designate sound files. In Profile 
Properties dialog box, open the dialog box by clicking [Sound Settings] button in the [Devices] 
tab.  

Bell Type 
Select an appropriate audio device for bell request by an X application. Select one from among 
three bell types: Sound Card, PC Speaker and None.  
If Sound Card is selected, an appropriate sound file (.wav) must be designated. If None is 
selected, no bell sound is generated.  

Sound File 
Show a sound file (.wav) to be used for bell request of X applications.  

Browse 
Select a sound file by opening Open dialog box.  

 

Multi-monitor 
Xmanager enables users to select a monitor for X Window desktop output on a multi-minotor 
system. Xmanager may not operate successfully if a monitor is 8-bit color and other monitors 
are larger than 8-bit. It is therefore recommended that every color of the monitor is set to 16-
bit color or higher.  

To Select Monitor for X Desktop: 
1. Run Xconfig. 
2. Double-click a profile. Profile Properties dialog box is displayed.  
3. Click the [Devices] tab.  
4. Click [Monitor Settings]. Monitor Settings dialog box is displayed.  
5. Select a monitor from the [Monitor to use] list.  
6. Click [OK].  

 Note 
Monitor list shows all monitors available for use including Auto detect and Virtual Screen.  

Virtual Screen is a virtual rectangular area that includes all monitors. 

When Auto detect is selected, Xmanager selects Virtual Screen in Multiple Window Mode 
and the main monitor in Single Window Mode.  

To Use All Monitors as a Single X Desktop:  
1. Run Xconfig. 
2. Double-click a profile. Profile Properties dialog box is displayed.  
3. Click the [Devices] tab.  
4. Click [Monitor Settings]. Monitor Settings dialog box is displayed.  
5. Select Virtual Screen from the [Monitor to use] list. 
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 Note 

Virtual Screen is listed only when there are several monitors on a system. The Virtual 
Screen created root window size and workspace are affected by the resolution and layout 
of each monitor. The root window is the largest rectangle comprising several monitors.  

6. Click [OK]. 

To Display Select Monitor Window at Startup:  
1. Run Xconfig. 
2. Double-click a profile. Profile Properties dialog box is displayed.  
3. Click the [Devices] tab.  
4. Click [Monitor Settings]. Monitor Settings dialog box is displayed.  
5. Select [Show the Monitor Selector at startup].  
6. Click [OK].  

Advanced Option Setting 

Set X protocol extensions and 
other advanced options in the 
[Advanced] tab of Profile 
Properties dialog box. For copy 
and paste option usage, see ‘Tab 
Management 
Xbrowser has powerful tab management feature. You can connect to multiple hosts and 
compare them side by side from a single window. Powerful tab management is a unique 
Xbrowser feature that cannot be found in other PC X Servers. 
 
Each tab is associated to a single Xmanager instance and it belongs to a tab group. Tab group 
is a collection tabs. A single Xbrowser window can have multiple tab groups and organize them 
any way you want. 

Tab 
By default, a new tab opens up when you open an XDMCP session. This allows you to work 
with multiple remote desktops without living Xbrowser window. You can align tabs vertically or 
horizontally.  
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To Open a Session in a New Tab  
1. Click [Tools] from the File menu 
2. For the Default Open action, select Open in Tab. 
3. Double click on a session in Xbrowser. 

 Note 

You can manually open a session in a new window by right clicking on a session and then 
selecting the Open in a New Window option. What you select in the context menu will 
override the default open action setting. 
 
To close a Tab 
4. Click the x button on tab. 

Tab Group 
Tab group is collection of multiple tabs. Only one tab from the tab group is visible at any given 
moment. You can manage multiple tab groups in a single Xbrowser and it allows comparing 
different tabs side by side without switching between applications. 
 
To Create a New Tab Group 
1. Open a new session by right clicking on a session and then selecting Open in New Tab. 
2. Click on the tab and drag it to a edge of the Xbrowser window. This will create a drop 

zone that indicates how the new tab group will be created. 
3. Drop the tab to a edge where you want to create a new tab group. 
 
To Move a Tab to a Different Tab Group 
1. Select a tab you want to move to a new tab group. 
2. While holding down the left mouse button, drag the tab to a different tab group. 
3. Drop the tab to a new tab group. 
 
To Close a Tab Group 
1. Select a tab group you want to close. 
2. Right click on the tab group in the background. 
3. Select the Close This Tab Group option. 
 
To Arrange All Tabs Vertically 
1. While many tabs open, right click on a tab. 
2. Point to Arrange and then select Arrange Tabs Vertically. 
 
To Arrange All Tabs Horitzontally 
1. While many tabs open, right click on a tab. 
2. Point to Arrange and then select Arrange Tabs Horizontally. 
 
To Arrange All Tabs Stacked 
1. While many tabs open, right click on a tab. 
2. Point to Arrange and then select Arrange tabs Tiled. 
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To Merge All Tab Groups 
1. While more than one tab group is showing on a single window, right click on a tab. 
2. Point to Arrange and then select Merge All Tabs. 
Copy, Save and Print in X Application’.  

Copy and Paste Automatically 
When the option is turned on, Xmanager copies and pastes texts or images in between an X 
application and a Windows application. When an X application copies texts or images, the 
contents are immediately forwarded to Windows Clipboard. Reversely, when new contents are 
added to Windows Clipboard, the contents are immediately forwarded to X Selection. Texts and 
images can be copied to both or either the Cut Buffer or X Selection. Selection of one may also 
need to be made depending on the X application.  

X Selection 
Use X Selection when copying and pasting contents in between Windows and an X application.  

Cut Buffer 
Use Cut Buffer when copying and pasting contents in between Windows and an X application.  

Copy and Paste on Changing Focus 
Run copy and paste only when a focus changes between Xmanager and another Windows 
application. When the focus is in Xmanager, the contents can be copied several times from X 
applications. Then, the contents are pasted to Windows Clipboard the moment input focus 
changes to another Windows program. If using this option while using Xmanager in Windows 
terminal, copy and paste may not function properly. 

Notify Display Change 
Display a dialog box when Windows desktop color or resolution is changed. If color or 
resolution is changed, Xmanager must be restarted. 

Maximize Performance 
Xmanager is executed at the maximum performance. Xmanager selects the fastest method 
for complicated drawing operations.  
However, some graphic images may not be displayed properly according to user’s video device 
or applications.  

Permit Old X11 Bugs 
Select this option when a remote X application is created in earlier versions than X11R6 and 
thus does not operate successfully in Xmanager. 

Accept Esound Request  
This is an option to process remote Esound requests. Esound uses TCP 16001 port. 

Detailed Log Message 
Use this option for detailed log message if necessary for technical support.  

Backing Store 
Select an appropriate Backing Store mode.  
The Backing Store is a function to store a hidden window area in memory. When a window is 
hidden by another window, it must be redrawn when it is revealed later on. By saving the 
obscured area in memory, Xmanager can recover the area faster than the application draws it 
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once again. In doing so, Xmanager reduces data transfer volume in a slow network 
environment.  
Xmanager provides four Backing Store modes. 
In Do Not Use mode, Backing Store function is turned off and the hidden fields are always 
redrawn.  
When Requested does not use Backing Store function either. However, when requested by an X 
application, Xmanager uses Backing Store function limitedly for the X application windows.  
In When Mapped mode, Backing Store function basically operates in all windows excluding 
hidden or minimized windows.  
In Always mode, Backing Store function operates in all windows including hidden or minimized 
windows. This option requires large system memory capacity and graphic resources.  

X Extensions 
Select X extensions to use. 
Xmanager supports BIG-REQUEST, DAMAGE, DEC-XTRAP, DOUBLE-BUFFER, Extended-Visual-
Information, MIT-SUNDRY-NONSTANDARD, Multi-Buffering, RandR, RECORD, RENDER, 
SECURITY, SHAPE, SYNC, TOG-CUP, XC-APPGROUP, XC-MISC, XEVIE, XFIXES, Xinerama, 
XInput, XKeyboard and XTEST extension protocols. In particular, it supports Render extension 
protocol and an improved graphic enviornment for X applications. In Xmanager Enterprise 
version, other protocols, such as GLX(OpenGL) extension protocol are also supported. 

X Resource Database 
Show path to X resource database to read when Xmanager is started. 

Change 
Display Open dialog box to change resource database to another file.  

View 
View resource database contents using Notepad. 
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Security 
Xmanager supports secure connection by providing host access control and SSH protocols.  
Host access control prevents connection from unauthorized hosts. However, network packet 
between Xmanager and an X application is not encoded and is vulnerable to intrusions.  
Xmanager also supports SSH protocol for security. SSH connection can be used in Xstart and 
Secure XDMCP sessions.  
Host keys and user keys database generated in Xmanager can be used Xshell and Xftp 
programs. Once a public key is created, it can be used in all programs without additional 
settings.  

Host Access Control 
Host access control manages a list of reliable hosts and enables only X applications from 
reliable hosts to connect to Xmanager. When connection by an unauthorized host is requested, 
Xmanager displays Alert dialog box asking whether to permit the connection. 

To Use Host Access Control Function: 
1. Run Xconfig. 
2. Double-click a profile. Profile Properties dialog box is displayed.  
3. Click the [Security] tab.  
4. Select [Enable Access Control].  
5. Enter a host for which to permit connection from the [Trusted Hosts] list.  
6. Click [OK].  

To Display Alert Message for Unpermitted Connection: 
1. Run Xconfig. 
2. Double-click a profile. Profile Properties dialog box is displayed.  
3. Click the [Security] tab.  
4. Select [Warn Unauthorized Connections].  
5. Click [OK].  

Public Key User Authentication 
To Open User Key Manager: 
1. Run Xbrowser. 
2. Click [User Key Manager] in the [Tools] menu. 

 Note 

Export, import, rename, delete and create a user key in ‘User Keys Dialog Box’.  

To Create User Key:  
1. Run Xbrowser. 
2. Select [New User Key Wizard] from the [Tools] menu.  
3. Create a user key according to the instructions provided by New User Key wizard.  

 Note 

Register a public key on a server at the last stage of key creation. Registration methods 
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vary according to key formats.  

• SSH1: Copy the public key text and save it to $HOME/.ssh/authorized_keys file. Run 
the following command to turn off the write permission of the files and directories. 
$ cd 
$ chmod go-w . .ssh .ssh/authorized_keys 

• SSH2-OpenSSH: OpenSSH servers use this format. Copy the public key text and save 
it to $HOME/.ssh/authorized_keys2 file. Run the following command to turn off the 
write permission of the files and directories. 
$ cd 
$ chmod go-w . .ssh .ssh/authorized_keys2 

• SSH2-IETF SECSH: Some commercial SSH servers, such as ssh.com server, use this 
format. Save a public key under an intrinsic name, such as mypublickey.pub and copy 
it to $HOME/.ssh2 directory. Add the following line to $HOME/.ssh2/authorization file: 
 Key mypublickey.pub 
Run the following command to turn off the write permission of the files and directories.  
$ cd 
$ chmod go-w . .ssh2 
$ chmod go-w .ssh2/authorization .ssh2/mypublickey.pub 

To Register Public Key in Server: 
1. Open User Keys dialog box.  
2. Select a user key to register.  
3. Click [Properties]. User Key Properties dialog box is displayed.  
4. Click the [Public Key] tab.  
5. Select a type that suits a remote SSH server from the [Public Key Format] list.  
6. Save public key by selecting [Save as a file] or copy the key contents and register the key 

in a server using the public key registration method listed above.  

To Change User Key Passphrase: 
1. Open User Keys dialog box.  
2. Select a user key for which to change passphrase.  
3. Select [Properties]. User Key Properties dialog box is displayed.  
4. Select the [General] tab.  
5. Select [Change Passphrase]. 

User Keys Dialog Box 
User Keys dialog box enables to create and manage user keys. Open this dialog box by 
selecting [User Key Manager] from the [Tools] menu.  

Import 

Select a user key file and import it by opening the Open dialog box. At present, Xmanager 
can read the SSH1 protocol RSA key, the OpenSSH SSH2 protocol RSA/DSA key, the SSH.COM 
key, and NetSarang user key formats.  

Export 

Save a selected user key file by opening the Save dialog box. Exported file types are 
NetSarang user key, OpenSSH  SSH2. NetSarang user key format files can be used in 
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programs developed by NetSarang Computer, Inc.  

Delete 

Delete a selected user key from database. 

Rename 

Rename a selected user key. Key name must be valid as a file name.  

Properties 

Show user key attributes. Type, length, fingerprint and public key can be viewed. Additionally, 
the key passphrase can be changed.  

Generate 
Open New User Key wizard.  

SSH User Authentication Dialog Box 
SSH User Authentication dialog box enables users to select appropriate authentication 
methods. If a passphrase is not saved in a session, this dialog box is displayed in case it is 
necessary to obtain authentication-related information from the user.  

Password 

Password authentication is to permit a user to log in to a server by entering the user account 
password. Due to security reasons, some servers do not support this authentication method.  

Public Key 

Public key authentication requires a user’s public key to be registered in a remote SSH server. 
To log in using this method, select an appropriate user key from the user keys list.  

Keyboard Interactive 
Keyboard interactive acts as a server asking questions and the user entering messages.  

Host Key Management 
A host key is a remote host public key, through which users can verify hosts by their fingerprint. 
When a connection is made, the remote host sends its public key to Xmanager. For a host 
that is connected with for the first time or when a host key is not saved in database, SSH 
Security Warning dialog box is displayed at connection. If a host key is valid and reliable, 
save the host key in host key database.  

To Open Host Key Manager: 
1. Run Xbrowser. 
2. Click [Host Key Manager] in the [Tools] menu. 

SSH Security Warning Dialog Box 
SSH Security Warning dialog box is displayed when a remote host key is not saved in the 
host key database or when the fingerprint of a remote host key differs from the fingerprint of 
the saved host key.  

Accept Once 
Accept a host key for this connection only. The host key is not saved and the same dialog box 
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opens at the next connection. This function is useful when the server host key changes often or 
if the server is not frequently connected.  

Accept and Save 

Save a host key and continuously process connection. This dialog box does not open for the 
next connection. This function is useful when a fingerprint is correct and the host is connected 
with frequently.  

Cancel 
A host key is not accepted and connection is cancelled.  

Host Keys Dialog Box 
The host keys dialog box permits the management of host keys in relation to hosts to which 
connections are permitted.  

Import 

Import a host key by opening Open dialog box. The imported host key is saved in the host key 
database and is displayed in the Host Keys dialog box. Files saved in the SECSH public key 
format can be imported.  

Export 

Export a selected host key by opening Save dialog box. The exported keys are saved in the 
SECSH public key format and can be used in other programs.  

Delete 

Delete a selected host key from database. 

View 
Open a selected host key with Notepad. 
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Tab Management 
Xbrowser has powerful tab management feature. You can connect to multiple hosts and 
compare them side by side from a single window. Powerful tab management is a unique 
Xbrowser feature that cannot be found in other PC X Servers. 
 
Each tab is associated to a single Xmanager instance and it belongs to a tab group. Tab group 
is a collection tabs. A single Xbrowser window can have multiple tab groups and organize them 
any way you want. 

Tab 
By default, a new tab opens up when you open an XDMCP session. This allows you to work 
with multiple remote desktops without living Xbrowser window. You can align tabs vertically or 
horizontally.  
 
To Open a Session in a New Tab  
5. Click [Tools] from the File menu 
6. For the Default Open action, select Open in Tab. 
7. Double click on a session in Xbrowser. 

 Note 

You can manually open a session in a new window by right clicking on a session and then 
selecting the Open in a New Window option. What you select in the context menu will 
override the default open action setting. 
 
To close a Tab 
8. Click the x button on tab. 

Tab Group 
Tab group is collection of multiple tabs. Only one tab from the tab group is visible at any given 
moment. You can manage multiple tab groups in a single Xbrowser and it allows comparing 
different tabs side by side without switching between applications. 
 
To Create a New Tab Group 
4. Open a new session by right clicking on a session and then selecting Open in New Tab. 
5. Click on the tab and drag it to a edge of the Xbrowser window. This will create a drop 

zone that indicates how the new tab group will be created. 
6. Drop the tab to a edge where you want to create a new tab group. 
 
To Move a Tab to a Different Tab Group 
4. Select a tab you want to move to a new tab group. 
5. While holding down the left mouse button, drag the tab to a different tab group. 
6. Drop the tab to a new tab group. 
 
To Close a Tab Group 
4. Select a tab group you want to close. 
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5. Right click on the tab group in the background. 
6. Select the Close This Tab Group option. 
 
To Arrange All Tabs Vertically 
3. While many tabs open, right click on a tab. 
4. Point to Arrange and then select Arrange Tabs Vertically. 
 
To Arrange All Tabs Horitzontally 
3. While many tabs open, right click on a tab. 
4. Point to Arrange and then select Arrange Tabs Horizontally. 
 
To Arrange All Tabs Stacked 
3. While many tabs open, right click on a tab. 
4. Point to Arrange and then select Arrange tabs Tiled. 
 
To Merge All Tab Groups 
3. While more than one tab group is showing on a single window, right click on a tab. 
4. Point to Arrange and then select Merge All Tabs. 

Copy, Save and Print in X 
Application 
Automatically copy character strings in between an X application and Windows Clipboard using 
Xmanager. Additionally, when using local window manager, X application images can be 
copied to the Windows Clipboard, saved as bitmap files and printed by a printer.  

To Set Automatic Copy and Paste: 
1. Run Xconfig. 
2. Double-click a profile. Profile Properties dialog box is displayed.  
3. Click the [Advanced] tab.  
4. Select [Copy and Paste Automatically] from the [Settings] list.  
5. Click [OK].  

To Copy Character String from Xterm to Windows Notepad: 
1. Select a character string to copy from xterm window with left mouse button.  
2. Start Notepad. 
3. Select [Paste] from the [Edit] menu. 

To Copy Character String from Windows Notepad to Xterm: 
1. Select a character string to copy from Notepad with left mouse button.  
2. Select [Copy] from the [Edit] menu.  
3. Run xterm. 
4. Click the middle mouse button or left and right buttons simultaneously in the xterm 

window.  
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To Copy X Application Window to Clipboard: 
1. Point to [Copy] in the title bar system menu and select [Window] or [Content]. Window 

image is copied to clipboard.  

 Note 

This function can be used when the local window manager is in operation under Multiple 
Window Mode. 

To Save X Application Window as Bitmap File: 
1. Point to [Save] in the title bar system menu and select [Window] or [Content]. Save As 

dialog box is displayed.  
2. Enter an appropriate file name in [File Name].  
3. Click [OK].  

 Note 

This function can be used when the local window manager is in operation under Multiple 
Window Mode. 

To Print X Application Window: 
1. Point to [Print] in system menu on title bar and click [Window] or [Content]. Print dialog 

box is displayed.  
2. Click [Print]. 

 Note 

This function can be used when the local window manager is in operation under Multiple 
Window Mode.  

  

58 | Error! Use the Home tab to apply 제목 1 to the text that you want to appear here. 



 

Session Log 
Xmanager session records debug information as files. When several Xmanager sessions are 
being used simultaneously, each session log is saved under different names, such as X0.LOG 
and X1.LOG. Number in the log file refer to a display number of the Xmanager session.  
Checking log files can be helpful when problems occur while using Xmanager. 

To View Log Files of Current Session: 
1. Right-click on the Xmanager notification area icon or click the Xmanager icon in the 

Xmanager main window title bar.  
2. Point to [Log] in system menu and select [File]. A log file is opened with Notepad. 

 Note 

In Multiple Window Mode, the Xmanager icon is created in the notification area. In Single 
Window Mode, Xmanager opens a single main window.  

To Open the Folder where All Session Log Files are Saved: 
1. Right-click on Xmanager notification area icon or press Xmanager icon in the 

Xmanager main window title bar.  
2. Point to [Log] in system menu and select [Folder]. A log folder opens.  

 Note 

Open a log folder by selecting [Open Log Folder] from the [File] menu in the Xbrowser.  
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